
CodeTopo 
v 3.0.2 - Mutatis mutandis

User Guide

© Renaud Gosselin,  2008-2012 Paris, september 2012





Summary

Introduction ……………………………………………………….…. 1

CodeTopo and automatic drawing       ……………………………éééé……….……. 1

Installation and system requirements …………………………………….……. 1

Presentation of the software …………………………………….……. 1

1 - import and organize data in CodeTopo …………………………………..…….3

1.1 - Import data from external file ……………………………………….… 3

1.2 - Identify and present the data ………………………………………………….……….4

1.3 - Reorganize the data ……………………………….……………………….…5

1.4 - Capture coordinates from bitmap picture          ……………………………………… 8

2 -  Modify and save data ……………………………………………………….11

2.1 - Edit et modify the data …………………………………………………………11

2.2 - Incorporate data to readjust a graphic with other pictures   ……………………….13

 2.3 - Convert geographic coodinates in cartographic coodinates …………….….…….14

2.4 - Save the modifications ……………………………………………….………...15

3 - Define options of the graphic ………………..……………………………….……16

3.1 - Define general options …………………………………….…...16

 3.2 - Define options for the appearance of objects ……………..……..…... 20

3.3 - Save preferences of the graphic ……………….……...…21

4 - Draw graphic ……………………………………………….……….. 22



5 - Calculations and reseach of informations from coordinates  ….…………….24

 5.1 - Calculate  ……………………………….……………..…….….. 24

5.2 - Search for information via Internet …………………………………….…..25

6 - Problems and solutions …………………………………...……26

7 - What's new in version 3.0 ? ………………………………….…..…………………27

8 - CodeTopo sofware : Licence to use ……………………………….…….…28

9 - Register its copy and search for updates ……………………..…………………29

10 - Contact the author ……………………………………………….……….30

Attention, some screenshot are from the French version of CodeTopo. The 
French texts are obviously translated in the English version of the software.



Introduction

CodeTopo and automatic drawing

CodeTopo is a software designed to automatically draw graphics from lists of points that 
represent Cartesian coordinates. It will interest especially those who work with Topographics 
data obtained using tacheometers or GPS systems. In professional environment, or even for 
personal use, CodeTopo will save time on the elaboration of drawings. No need to trace, 
manually, the outline of objects by linking each of their points.

Indeed, from a sequence of points localized in X and Y, CodeTopo will determine the element 
of graphic to which they belong (a road, a building, or a trench, for example). Then, it will 
generate the path of this object, as well as all the objects contained in the same list of points.

CodeTopo allows to create vector drawings very quickly. These drawings are saved as PDF 
files, and could be edited with most of the design software such as AutoCAD™, Canvas™, 
CorelDraw™, or Illustrator™ for example.

Installation and system requirements

CodeTopo can be installed on any computer equipped with the following systems: Mac Os X ; 
Windows 95 / 98 / NT / 2000 / Me / XP ; or Linux.(under some reserves).

When the file is downloaded from the web site, it is compacted. Before you can use CodeTopo, 
You'll need to uncompress it with an utility that manages the ".zip" file format.

Presentation of the software

The main window of CodeTopo is divided into three parts. The menubar and the toolbar, form 
the upper part, and provide quick access to all functions of the software.

Below, there is a table (or field) that will receive the data imported from an external file. This 
table is itself surmounted by popup menus that allow to define: the measurement system in 
activity, and distribute information from table 1 to table2. Finally, in the lower part of the main 
window, the second table is used to hold the result of the changes made from the data of table 
1.
Data can be entered directly by the user in the one or the other of the fields. But CodeTopo wil 
crate graphics only from the data of Table !

The file containing the original data is never affected by the operations realised in CodeTopo. 
To save changes made on the imported data it is necessary to export them by using the button 
or the menu  provided for that purpose (see below).

The interface of CodeTopo was designed to be as clear and intuitive as possible. By placing the 
cursor over the buttons at the top of the main window, you will get a brief explanation of the role 
of these elements.
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The main window of CodeTopo, here for the Windows system
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1 - import and organize data in CodeTopo

1.1 - Import data from external file

The first step is to write, in CodeTopo, the data that will be drawn. Typically, it is Topographics 
or Cartographics coordinates  obtained using equipment such as tacheometers or GPS 
systems. CodeTopo does not import data directly from these devices and they must therefore 
have been beforehand recorded on a physical support accessible to the user, such as a hard 
disk or a USB key.

  To import data from an existing file, we select the menu item "Import ..." from the "File" menu, or 
we click on the button:

A dialog box appears that allows to select the file to import. CodeTopo treats  "text only" (ASCII), 
"kml" (Google Earth ™), or "Spreadsheet" (Excel or OpenOffice ™, for example) files. These 
different formats are available at the bottom of the window to access files.

The imported data are stored in the table 1. Importing data also erase the contents of the table n
° 2 if it is not empty, but with the consent of the user.

Important to know !!
 
To work correctly CodeTopo requires that the data are imported from a file in wich the values 
are separated, rather, by  tabs and in wich the decimal separator is a point (".").

If the data of the original file are separated by characters like the comma (",") or semicolon (";"), 
these characters are automatically transformed into tabs during import.

In addition, when importing data that the decimal separator is a comma, the software will 
automatically convert commas in points. Therefore beware to the fact that: if the definitions also 
contain commas or semicolons, these characters will be converted into signs "point".
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Very important, read the next chapter !!

1.2 - Identify et present the data

During the execution of automatic drawing, CodeTopo will consider as belonging to the same 
object all the lines in the table n° 2 which follow each other, and whose definition (the contents 
of the first column) is identical.

For example, the following lines:

House 1 646340.276 6892722.516
House 1 646347.030 6892689.308
House 1 646344.037 6892689.390
House 1 646344.718 6892691.441

will be considered as a single object, the "House 1", while the lines

House 1 646340.276 6892722.516
House 2 646347.030 6892689.308
House 3 646344.037 6892689.390
House 4 646344.718 6892691.441

will be considered as four different objects sharing the same type (click here for an 
illustration of this principle).

Therefore, once the data have been imported, it is necessary to clearly identify (thanks to popup 
menus which lie above the columns of the tablen° 1) those that correspond to :

• the definition of objects = column 1 of table 2;
• the X axis = column 2 of table 2;
• and the Y axis = column 3 of Table 2.
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If the imported data are already in the order indicated above, it is possible to transfer them 
directly from the table n° 1 to table n° 2 by selecting the menu item "transferred ..." of Menu 
"tables ", or by using the next button:

The transfer is particularly useful for large lists with thousands of points data and when no 
change are necessary between the moment these data are imported and when they are drawn. 
Before the transfer, in order to avoid a crushing unintentional data, a confirmation will be 
requested.

Before starting the process of automatic drawing, it is imperative to verify data contained in the 
field 2. The columns of X and Y axis must not contain negative values or outliers, like empty 
cells or "0" for example. If CodeTopo detects outliers of data, it will interrupt the automatic 
creative process. If it does not detect, the risk is to get an unreadable graphic output!

Finally, for a correct execution of the automatic drawing, the first line of table 2 does not 
contain the definition of the columns. If such a line appears in the beginning of the list, 
CodeTopo will offer to automatically remove it.

Note: altitudes (Z axis) are not taken into consideration in CodeTopo. However, their presence in the list of 
items not disturb the automatic drawing.

 
1.3 - Reorganize the data

In order to improve the automatic process of drawing, it is possible to reorganize the data 
imported in table 1, or those already transferred in Table 2. Functions: permute, bring closer, 
merge, which are available via the "Permutations" window, are there to facilitate this work. 

You can access this window, and these functions by clicking the button below,
or by selecting the corresponding menu items in the Menu "Tables".
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The window  to permute or bring closer the data

 The permutation of the data consists in exchanging the place of columns or lines within the 
table of data. So, if you wish that the legend of points does not corresponds to the definition of a 
type (" house 1 ", for example), but corresponds to the height of each of the points, it is enough 
to permute the column n° 1 with the column which contains the altitudes.

ex : [ 1  I 2  I 3  I 4  I 5 ]  => [ 4  I 2  I 3  I 1  I 5 ]
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The rapprochement of the data allows to group together coordinates that belong to the same 
objects, but were dispersed during their recording. Indeed, if the lines with coordinates of 
points which belong to the same object do not follow each other in the table n° 2, CodeTopo 
cannot connect these points between them during the automatic drawing.

Take the case of a limit of parcel,  for example. We will bring close the lines that belong to this 
limit by inscribing "parcel" in the field of the permutation window dedicated to this purpose. By 
clicking the "Bring closer" button, we will gather all rows in the table 2 that contain "Parcel" in 
their definition of object.

The merge of columns allows to replace several columns by a single column while preserving 
their content.The contents of the merged columns can be: either appends, or adds.

Merge example by appending the content of three columns :        [ 1  I 2  I 3 ]     =>  [ 123  ]

Merge example by adding the contents of three columns :        [ 1  I 2  I 3 ]     =>  [ 6  ]
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1.4 - Capture coordinates from bitmap picture

It is possible to recover Cartesian coordinates otherwise than importing them from an external 
file. Indeed CodeTopo provides a way to create these coordinates through the "Capture 
coordinates" window. We can access this window by selecting the menu item "Capture from a 
picture..." of Menu "Data", or by clicking on the button:

The capture coordinates window

In this window, are imported by clicking the button below the image that we want to vectorize. It 
can be a scanned document, an Internet document, etc., but the images must be formatted as : 
GIF, JPEG, PNG, BMP, XWD, XBM, XPM, PBM, PGM, PPM, or PICT format.
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We indicate, thanks to the cross cursor and by clicking with the mouse, a point of this map which 
will serve as local reference with regard to the active window...

... then we introduce the real values of this point in the original mapping system.

We choose the delay between the automatic 
capture of each point during the recording of a new object, and while the mouse button is down. 
The higher is this number, the lower wil be the number of captured points.
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The recording of a new object begins by clicking on the next button :       
 
It will be asked to choose a name for the object, and then we click as often as necessary on the 
imported image, by following the shape of the element that we wish to vectorize (It is also 
possible to let the mouse button down and to follow the outline of an object).

   

By clicking on the image, the real coordinates are automatically written in the field situated at 
the bottom left of the window. To stop the recording of an object, press the "alt" button 
("option" on Mac keyboard).

Finally, when we have the coordinates of all the interesting elements, we transfer them in the 
field n°2 of the main window of CodeTopo by using the button provided for that purpose :

An example of vectorized drawing obtained from a scanned image
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2 -  Modify and save data

2.1 - Edit et modify the data

In addition to the changes affecting the automatic drawing of data, CodeTopo integrates several 
functions that allow working on the edition of the data themselves.
To manually edit the data, it must be ensured that the tables are unlocked. The button below 
allows to lock or unlock the tables :

List of functions edition

[menu item " Erase…"  of Menu "Edition" ]
Delete the contents of the tables of data. If nécessary, the action of this command will affect 
simultaneously the contents of both fields.  To avoid unintentional overwriting of data, 
confirmation is requested.

[menu item " Find…"  of Menu "Tables" ]
open a window to find and replace a suite of characters, a word or another value. The search 
window can also replace all the elements of a column according, or not, on the value of each of 
these elements. Changes made through the search window may affect both the data in Table 1 
and the data contained in table 2.

[menu item " Sort…"  of Menu "Tables" ]
Sorts lines of the data table n°1 according to the values of one of its columns / headings.
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Finally, the menu item "Merge lines…"  of Menu "Tables" Allows to combine, in a single line, 
several lines beforehand selected, while adding the values contained in each of the columns 
which compose these lines (if these columns contain only numeric values, of course).

example : two lines are selected (here in blue) and are grouped together to obtain (in red) the 
sum of the columns 2 and 3.

[  Coffer 1 3000 +
[  Coffer 1 12000 = Coffer 2 15000
   Stool 1 6000 Stool 1 6000
   Vase 1 1000 Vase 1 1000

the grouping can be pursue by adding "Coffer" and "Stool"

[  Coffer 2 15000 +
[  Stool 1 6000 = Stool 3 21000
   Vase 1 1000

Note : this command works even when the object definitions are not identical.  In this 
case, the definition of the aggregated lines will be the value of the definition which is located in 
the last one of the selected lines ("stool" in our second example).
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2.2 - Incorporate data to readjust a graphic with other pictures

In CodeTopo, it is possible to add automatically a peripheral grid (carroyage) around the plan. If 
you ther is no need of peripheral grid but if we wish nevertheless to be able to easily locate a 
map (in a cartographic system, for example) or to facilitate the calculation of the scale of a map, 
we can introduce two "whole" values in the columns of points. We will give, as definition of 
these values, a title which will correspond to the value of X and Y (put side by side) as shown in 
the next example : 

Definition of objects  X axis  Y axis

extract of a plan
  reference points for the calculation of the scale, or readjustment of the map
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2.3 - Convert geographic coodinates in cartographic coodinates

Numerous tools are available on Internet which allow to convert coordinates between different 
geographical and / or cartographic sytems. However, some of these tools only authorize the 
transformation of a single point at once, or are only available for the Windows system.

That's why CodeTopo contains a module of coordinates conversion which can be accessed by 
selecting the menu item "Convert ..." of the "Data" menu or by clicking on the button:

This module allows to convert automatically all the coordinates present in the field n°1 and to 
transfer them in the field n°2. For that purpose, geographics data of table 1 must be expressed: 
either in decimal degrees, or in sexagesimal degrees.

The first case present a particular interest to those who work with coordinates of points 
associated with the WGS84 geodesic system (such as users of GPS, for example). The data to 
be converted must be present in the form:

code Longitude Latitude Altitude
 Point 1 1.1390274101 29.9757323377 0

Cartographic system used for conversion is the UTM projection system, so the result of the 
conversion will be :

Code X Y alti UTM zone
Point 1 320453.9210 3317553.4766 0 36

If the geographic data are expressed in sexagesimal degrees, they thave to appear in the 
following way :

(1) Definition (2) degrees (3) minutes (4) seconds (5) direction
(6) degrees (7) minutes (8) seconds (9) direction

ex : code ° '' ' dir ° '' ' dir
ex :  Point 1 45 66 41 N 42 32 34 E
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Attention, for the moment the possibilities of conversion are still limited, and concern essentially 
the French system of cartographic projection (Lambert).

    The module of coordinates  conversion (here in the french version).

2.4 - Save the modifications

Once the changes made, it is possible to print them via the corresponding menu item of the 
"File" menu, or by clicking on the button:

It is possible also to save these changes by exporting the contents of the table data n°1 or 2, to 
a "Text only" file format which may, if necessary, be imported. This is done using the menu item 
"Export ..." from the "File" menu, or by clicking the following button:
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3 - Define options of the graphic

3.1 - Define general options

One of the main steps in CodeTopo is to define the graphic options. You can access these 
options by selecting the menu item "Graph options…" of menu "Data", or by clicking the 
following button:

The options window allows to define, through two tabs, options such as the mode of 
representation of objects, the color of the text or of the path of objects, the presence of a legend, 
the presence of a peripheral grid, etc.

La fenêtre des options : les options generales
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In the first tab (General Options), you will configure CodeTopo to generate automatically: 
cartridge, orientation, scale, or to incorporate informations such as the title of the graphic, the 
author's name, etc.

It must be specified that length of the drawn scale is always equal to 5 cm (142 pixels). The 
drop-down menu associated with this function allows, on the other hand, to define the unit of 
measure in use and indicates CodeTopo the scale at which the graphic should be drawn.

CodeTopo offers several options in this tab designed to facilitate and accelerate the elaboration 
of a graphic. Thus, at the request of the user, it can draw Cartesian coordinates of each point of 
an object as a small square accompanied by its sequence number in the list of points.

one option of the drawing : the addition of numbered points

It may also automatically draw the perimeter of a circle from two points which are designated as 
belonging to the same objet. Finally, by way of "ultimate sophistication", it could connect the 
points of the outline not with simple lines, but with Bezier curves.
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Transformation and smoothing of the outiline of an object using Bézier curves.

When we define the graphic options, we should not forget to indicate, using the checkbox, if the 
outline of objects must be closed or not. In the first case, CodeTopo creates a polygon from the 
points that belong to the same object * and fills the polygon with the color that has possibly 
been associated with this type of objects (see below). In the second case, CodeTopo simply 
connects each of the points of the lines belonging to the same object.

By default, the button : "Close the outline of objects" is checked. In that case, the drawing of 
outline of each object defined in the options window can be disabled, individually.

CAUTION, when the button "Close the outline of objects" is not checked, this option will be 
applied to all objects of the graphic.
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* REMEMBER : CodeTopo considers as belonging to the same object of a graphic all adjacent 
lines of table n° 2 whose definition (contents of the first column) is identical. An object defined 
by a single line of the table 2 will be considered as an isolated point and will be draws in this 
way (see example below).

Cloud of points. Drawing realized when each point has a different definition (code).

Drawing realized when checkbox "Close the outline of objects" is not checked. In this sample, CodoTopo 
has identified seven objects.

Drawing realized when checkbox "Close the outline of objects" is checked.
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3.2 - Define options for the appearance of objects

In the second tab of the "Options" window (Appearance of objects), we can find a series of 
popup menus - under the guise of small black triangles (  ) - that allow to associate a definition 
of object with attributes (colors of fill and outline, for example). This association is realized 
without the need to inscribe these definitions manually.

Indeed, the types of objects accessible via the popup menus reflect the content of the column 
selected by the user using the menu located above the fields of definition.

For example, in the list below, the contents of the column 5 ("Other criteria") will determine the 
attributes for the objects "House."

Code X Y Z Other criteria

House 1 646340.276 6892722.516 0 group 1
House 1 646347.030 6892689.308 0 group 1
House 2 646344.037 6892689.390 0 group 2
House 2 646344.718 6892691.441 0 group 2

Attention! the popup menus are active only when the user has selected a column number and, 
of course, if the corresponding column of Table 2 is not empty.

Several types of objects can share the same attributes. It is sufficient for that to include them in 
the same field of definition, separated with a comma. To enter multiple definitions in a single 
field using one of popup menus, simply select the items on this menu by holding the Shift key.

To duplicate the color of a button to other buttons of this tab, we just click on it while holding 
down the Shiftkey, then we drag the pointer over the buttons which we want to assign the same 
color.

During the automatic drawing, an object whose color has not been defined will be drawn with 
the default color (pale blue).
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The options window : definition of object attributes.

3.3 - Save preferences of the graphic

When all options are set, it is possible to save the configuration using the drop-down menu 
located at the bottom of the "Options" window.

Configurations are saved in a external preferences file, placed in the same folder as CodeTopo. 
Configurations can be recall or modify with the same menu.
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4 - Draw graphic

Once the data has been verified and possibly re-arranged, it remains only to click on the "Draw 
the map" button or choose the corresponding menu item in the Menu "Data".

If no options has been set for the graphic, CodeTopo will automatically redirected the user to 
the options window. Otherwise, a dialog box will ask to choose the name of the file, as well as 
its location on the disk. Drawing will be saved as PDF.

Before drawing the chart, CodeTopo performs data verification. If it detects "suspicious" 
coordinates, it will notify and will offer to suspend the execution of the drawing. It's possible to 
ignore the warning and continue with this step by simply clicking on the button "Continue" on 
the dialog box that appeared.

Once the graph is drawn and stored on the disk, it is possible to automatically open it with the 
application of his choice. Simply hilite the relevant box in the options window and choose the 
default application (attention : Some applications do not respond to this command, or do not 
recognize the PDF format).

If, after the whole process, the map is not properly designed, it is necesary to check carefully the 
data of table 2, and then restart the automatic drawing procedure. In general, failures of the 
drawing come from  the presence of incorrect coordinates.

Drawing a map with CodeTopo is very fast. For example, the realization of a map from a list of 
more than 32,000 points was tested with a Windows XP computer, equipped with an Intel 
"Pentium 4 " (2.8 GHz, and 1 GB of RAM).
The 32,371 points were processed in 366 seconds or a little over six minutes, generating a PDF 
file of about 1.7 MB.
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An example of a plan realized in a few fractions of a second by CodeTopo
and from Cartesian coordinates.
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5 - Calculations and reseach of informations from coordinates

5.1 - Calculate

Beyond the creation of automatic drawing, CodeTopo offers some functions associated to the 
treatment of the Cartesian coordinates points. It allows to calculate area, perimeter and centroid 
of objects whose points are selected.

These calculations are realized in a window which is accessed by selecting the menu item 
"Calculate ..." of Menu "Data", or by clicking the following button:

It will be possible also to calculate the distance between two points of the list, or the distance of 
all objects in a graphic over one of them.
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5.2 - Search for information via Internet

Another feature introduced in version 3 of CodeTopo is the possibility of obtaining informations 
on a coordinates soliciting other providers such as Google, for example.

You can access this window by selecting the menu item "Locate via the WEB ..." of Menu "Data", 
or by clicking on the button:

Note: This function is considered as being in testing phase.

Search informations on coordinates via Internet (here in the french version)

CodeTopo v3 - user Guide 25



6 - Problems and solutions

This section describes problems that can be encountered, and help to determine the cause of those 
problems.

I do not succeed in importing the data, or the imported data contain strange characters.

R - Verify that the file is registered in "Text" format : it has to contain no typographic enrichment, 
no elaborated layout, etc.

I have imported the data from a "Text only" file format, but when I press on the button "Draw the 
plan", CodeTopo says that there is nothing to draw !

R - It is necessary to transfer the imported datas from table n°1 to the table n°2.

It is possible to do it by clicking the "transfer" button (see above) if columns are already sorted in 
the following order : definition of the object ; X axis ; Y axis. It is possible also to do it  by 
indicating, by means of pop-up menus over the field n°1, the column which corresponds to the 
definition of objects ("object"), the one that corresponds to the X axis and the one that 
corresponds to the Y axis.

I draw a map with CodeTopo, but when I open the PDF document, the page is empty.

R - Verify the nature of the data. It is likely that one (or some) number (s) contains one (or some) 
incompatible character (s) with the good execution of the script. The case of the sign "," as 
decimal separator was already evoked. Remind yourselves that the value of numbers must to 
be not negative.

R2 - If the size of the document is very big, it is possible that the objects of the plan are showed 
at a very small scale. In your drawing software, choose the menu command : "Select all", to see 
if the document is not empty. If a selection appears, zoom until you can identify the objects.

R3 - All the software does not manage the documents of very big dimension. In Adobe 
Illustrator, for example, the maximal size of the illustrations cannot exceed 16383 x16383 
pixels.  In a software such as: "AutoCad", on the contrary, it seems than there is no limit.

I succeed in obtaining a cloud of points, but no outline was closed in the drawn objects.

R - Make sure the button "Close the outline of objects "is hilited. If the answer is "yes", it means 
that all the coordinates of the list have a different definition / nomenclature.

I chose an application to open automatically saved files, but once opened, the application does 
not open the saved maps.

R - some applications will launch, but refuse to open a file by script. Open the file by choosing 
"Open..." from the "File" menu of these applications
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7 - What's new in version 3.0 ?

Version 3.0 is a major update of CodeTopo

- Significant change of the elements of the main window interface ; add the numbering of 
the lines and columns, and adding menu items to call the new functions of the software. 
A popup menu allow, in particular, to adjust automatically the width of columns 
depending on the width of the content.

- For the drawing, the color of objects can be henceforth associated with another column 
that the the one that contains legend of the points.

- It is possible now to define the scale at which the graphics will be designed.

- Modification of the interface in the window dedicated to graphic options. These changes 
accompany the addition of new features.

- Adding functions to realize calculations (area, perimeter, etc.) directly from the list of 
Cartesian coordinates.

- The outline of objects can be previewed in an external window before drawing.

- Convertion of coordinates expressed in decimal degrees in the WGS84 geodetic datum 
into cartographic coordinates in the UTM mapping system.

- Combination of several functions dedicated to the treatment of lines and columns of data 
in one external window.

- Modification of the interface of the window to open and import files.

- Other bug fixes and minor additions.

- CodeTopo henceforth is distributed under shareware license including individual users.
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8 - CodeTopo sofware : Licence to use

CodeTopo is distributed as shareware.

As part of the evaluation: installation, copying and use are free for one month, without any other 
requirement that a registration.

After a trial period of one month, the use of the software is subject to the purchase of a license 
and the registration of the user with the software author.

The user is authorized to make as many copies of the software it deems necessary, and 
remains responsible for the physical safety of these copies. At the end of the trial period of one 
month, if he wishes to continue to use this software, he must purchase a license for each copy 
of CodeTopo that will be installed.

The software is provided as is without warranty. The author can not be held liable for damages 
of any nature whatsoever suffered by the user or third parties arising directly or indirectly from 
its use, including loss of data, or any financial loss resulting from its use or inability to use, and 
this even if the author has been advised of the possibility of such damages.

This software is protected in France by the Code of Intellectual Property and abroad by 
international conventions on copyright.

It is forbidden to translate, to adapt, to arrange, to modify the software as well as the 
documentation which is associated with it, even when these acts are necessary to allow the use 
of the software according to its destination. In application of the article L 122-6-1 of the code of 
the intellectual property, the author reserves the right to correct the errors, the particular 
modalities to which will be subjected acts being this defined before.

The reproduction of the code of the software or the translation of the shape of this code are 
forbidden even when they are indispensable to obtain the information necessary for the 
interoperability of the software with the other software.

By using this software, you make a commitment to respect copyright, and to watch that the other 
users respect them themselves.
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9 - Register its copy and search for updates

The menu item "Information, the" Help "menu, or the button below, to allow information to get to 
the current version of CodeTopo, as well as a first aid succinctly. Permettenr They also to 
access the registration form software, search for new versions of CodeTopo, or contact the 
software author.

The registration of CodeTopo is required for professionals and for individual users, after a trial 
period of the software of one month (see License).

The easiest way to acquire a license number is to go to the information window and click on the 
"Save" tab of this window. Then we click on the "Get a license number …"button.

In the Registration window (see below), after having complete the various fields of information, 
we finish the registration by clicking on the "Submit Form" button. CodeTopo opens the emailer 
of  the user to send the form to the author of the software. This procedure requires, of course, 
the presence of a software managing email on the user's computer.
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The cost of the license for each copy of CodeTopo is : € 5 ou $ 7.5, for personnal use, and € 35 
(or $ 49.99) for professional ou commercial use.

It is possible to pay the amount for the number of required licenses :

- By bank check, for holders of a French bank account ;

- By transfer between accounts, if the user has a bank account in the Euro area ;

- By Paypal-mail, in worldwide.

The registration allows the author to know the users of its software and to make it evolve. It also 
allows the user to be kept informed of such developments and receive update of the software.

10 - Contact the author

In case of problems during the use of this software, to provide a translation of this document into 
another language, to report errors or simply leave a comment (etc), contact the author at the 
following email address:

rg75@free.fr
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